IGSS Training on YouTube

Exercises

Exercise: Create Users and Assign User Privileges

Purpose Learn how to create new user groups, define their rights and assign users to the
groups using the User Administration program.
NOTE: To do this exercise, we want to use the IGSS demo configuration.
Therefore, you must go into the System Configuration program and make the
demo configuration the active configuration.
Duration Max. 25 minutes.
We want to create three user groups, and to simplify understanding how things
work, we will only create one user for each user group. Here's a matrix of what
we want as our result in this exercise.
User Administration Setup
User group Admin OpDay OpNight
name =
Global rights = \/ Can define B
\/ Can administer )
\ Can use system commands V can use system )
\/ commands -
Can use portal
\ Can define WinPager
settings
Protect object | Protect -4 Protect - 2 Protect- 1
rights =
Default Area = Overview Area = Plants Area = Global
diagrams = Diagrams in area = Objects Diagramsin area = Diagrams in
Manufacturing area = Welcome
User name & name: Bob name: Jim name: Pat
password = p/w: Bob p/w: Jim p/w: Pat
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Task 1: Create Our first task is to create the user groups to be used with the IGSS configuration
USer groups  +hat we made as the active configuration by opening it in the System
Configuration program.

Step Action

1. Open the User Administration @f program and select File — User Group.

2. Create the three user groups with the same names as shown in the table above:
e Admin
e OpDay
e OpNight

3. Select the Admin name in the All defined groups box and then give this group the Global
Rights as shown in the table above.

4. Now select the Area and Diagrams in area for this group as shown in the table above.

5. Repeat steps 1. to 4. for the two other groups as shown in the table above.

6. To complete the last part of setting up in the Protect objects rights area, go to the task
below and complete it.

Task 2: Setting up the  Now we must set up the various Protect object levels to be used on individual
Protect object rights objects in our project or configuration.

Step Action

1. On the File menu in User Administration, select Protect Objects.

2. Click on the Update list button if the window is blank to load the Protect 1 t0 4 levels.
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3.

7.

Click on Protect 4 Global and select all the rights in the list at the right.

Protect Objects

Ligt of Pratect abjects

Pratect 1 Glabal Can acknowledge alarms
Protect 2 Global .
Pratact 1 Global Can update =et points
] 4 Global Can update alarm limits
Can send commatds
Can update strings
Can update tables

Can open diagrams and areas

[ Update list l [ Delete ]

(7] Hiorohical

At the bottom, select the setting Hierarchical to have some of these these rights become
available for other Protect levels.

Click on Protect 3 Global and select the Hierarchical check box and nothing else.

Click on Protect 2 Global and select the rights as shown below.

Protect Objects

Lizt of Pratect abjects

—_

Priotect Glabal Can acknowledge alarms

[]Can update zet points
Global Can update alam limits
Can zend commands
[] Can update stings

[] Can update tables

[] Can open diagrams and areas

Protect
Frotect

= [

[ |Jpdate list ] [ Delete l

Finally, click on Protect 1 Global and select the single right as shown below, i.e. Can
acknowledge alarms.
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Protect Objects

Lizt of Pratect abjects

1 Glabal ¥| Can acknowledge alarms
Protect 2 Global . .
Protect 31 Global [] Can update set points
Frotect 4 Global [1Can update alam limits

[1Can zend commands

[] Can update stings

[] Can update tables

[]Can open diagrams and areas

[ |Jpdate list ] [ Delete l

[] Hierarchical

8. Click on the Close button when finished.
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10.

Now go back to the File — User Groups menu and make sure that each user group has
been given the correct Protect objects rights level as described in the User
Administration Setup table on page 62. Below we see the completed setup for the first
group we created, the Admin group, and we see under Protect object rights that this

group has been given Global — Protect — 4.

User Groups

All defined groups

OpDay [ Add Group ]
O pMight
[ Delete Group ]

Selected group

Group Hame Global Rightz:
Adrmin | Can define
Can adminizter

Drefault diagrarms
Cah uze spstems commands

Area : Can uze portal

||:|“"'3"""'3""‘I b | Can define wWinPager settings
Diagramsz in area
[]7Tproducts Pratect abject rights
[CIDizplay_Types tea - Protect object - level
[w]Objects []Global - Pratect - 1
[CIPlantTypes [1Global - Protect - 2

[Global - Pratect - 3
[w|Global - Protect - 4

tax no. of diagrams that can
be open simultaneausly: i

Cloze

Notice above that under Default diagrams, the Area called Overview and the Diagrams in
area called Objects have been selected as required by the User Administration Setup
table on page 62. Make sure that the two other user groups have their correct settings
selected for these parameters.
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Now we must create our users and their passwords and assign them to user

Task 3: groups created in Task 1 above.

Assign users to

user groups

Step Action

1. On the File menu, select Users and Passwords.

2. Click on New User and create Bob as a user, key in his name as his password and assign

him to the Admin group by first selecting this group in the drop down box next to User
group and finally by clicking on the Add Group button on the right..

3. Create the user Jim, key in his name as his password and assign him to the OpDay group
following the same procedure as you did for Bob.

4, Lastly, create the user Pat, key in his name as his password and assign him to user group
OpNight following the same procedure as you did for Bob.

Users and Passwonds

Lizt of defined Lsers
Baob [

Jir

Delete Uzer ]

[ Mew User ]

Selected uzer

b ember of groups
| | Opkight
IJzer name | Pat |

Fassword | m |

Full name

At logout bir.

User group | 0 pMight b | Add to Group

5 Click on Close when completed

6. Click on File — Exit to exit the User Administration program.
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Task 4: Our next task is to set up the "security lock" which we can apply to individual
Set the Protect objects in the configuration. It's called the Protect object and is always found in
object to security an IGSS configuration.

level 4

Step Action

1. Open the Definition program. On the Edit menu, select Open by Name.
2 In the Object Browser dialogue, click the + sign beside Global, then the + sign beside Digital.

3. TIP: Select the PROTECT template (spelled with ALL CAPS). The object named Protect
appears in the list to the right. Select it.

4. Under Open by name, select the Show properties check box and click the Open / Select
button.

Object Browser x|
[0 Area - i

-+{77] Counter rotect Global Digital
-7 Diagram
-2 Digital
@] (Hone)
(g7 MOTOR
(g POMPIE
lo7] PROTECT
--[g] PST_ALARM
(@] PIT_COMMNEC
(@] PST_PUMP
-[g] PST_START
--|g7] PST_STOP
[ PUMP

(g7 Resetalarm
-

77 fmranh
4 L3

— Tree node filter settings———————————— [~ List filter zetting:

. . X wild card test criteria
Criteria “wild card text criteria [~ Show reductions
IArea j I [~ Shaw only std. types
[~ Show only referenced Lo
IT_l,lpe [all possible) j I M
ITemplale j I r Open by nam:
V' Go to diagram
I[Unused] ﬂ I | e il Open / Select
 Create new objsct
Area [Global Mame |Pr0lecl
Template  |PROTECT Description |Controls cument security level Oto 5
Type [Digital v Name [~ Description
v Yalue [~ Maving sprbal Create
[~ Alwaps on top ¥ Advanced Close
’ . . . . .
5. Change State should be the tab that’s active. If not, click on it to activate it.
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Protect - Controls current security level 1 to 4

[rata b anagement Definitions | Edit Mapping |

Hame : IPrnlect FROTECT

Desc. : ICUnlrU\s current security level 1 to 4

Corrmands States :

Security level 1
Set secunty level 1 Security level 2
Set secuiity level 2 Securty level 3
Set secuity level 3

Free Walue : I 0

From 20-06-2002 10:44:51:577

Report Format

ChargsState | BitMapl/D |  AlaminfAckBt |  Command/State Config

6. NOTE: Under States: use the scroll bar to come down to Security level 4 and select it.

2=
|

oK I Cancel

Help

7. Click the OK button to save changes.

Task 5:

Connect the Protect
object to objects
needing extra
security

Our task now is to make sure that the special Protect object is actually connected
to the objects in the configuration for which we need extra security.

Step Action

on it and choose Properties.

1. Go to the Refuse disposal diagram under the Plants area, find the p3 pump and right click

2 Click the tab Data Management Definitions and in the bottom left hand corner of the dialog
box under Protection, select Protect in the drop down box. (See illustration below.)

Page 8 of 10



IGSS Training on YouTube

:ﬂg {Plants} Refuse disposal

Exercises

p3 @ Global - Water pump

| Edit b apping || Calculation || Feport Format || Symbal D
| Change State Il Bit Map /0
| Alarm Indack Bit || Command/State Config | [ ata Management Definitions
Scan interval Logging
() 2000 (10000 (&) All changes 2%
»1% »BE
O 5000 ® 30000 O Mone > 10%
Log outgoing commands
) None In millizecs. [ Logto SOL Database
Base interval [ ata reduction Transfer to hiztory
Oz O10 (® Reduced valus
O Actual total value
@5 (@)} O |dealized total valu
_ ) Nane
O MNore  Inmins. Al
reduction method
[ Log to printer @
/ Pratection Scale as Connect to
| E—

4 Click OK to save and exit.

5. Now go to the Dairy diagram also under the Plants area and right click on the g3 flow valve
and choose Properties.

6. Click the tab Data Management Definitions and in the bottom left hand corner of the dialog
box under Protection, select Protect in the drop down box. (See illustration below.)
SufBlants}.Dainy q3 @ Global - Flow tank 1

Calculation || Report Format ||_
Analog ” Alarm Indtck Bit | Data Managerent Definitions |
Scan interval Logging
(= 2000 10000 (® &l changes O»
Oz O
5000 © 30000 © None O
) Log autgoing commands
O Nome In millizecs. [ Log e SOL Database
Base interval [ ata reduction Tranzler to hiz
®: O10 (®) Reduced v
() ctual total
Q5 (@] O ldealized ta
o () None
N | 3
il [Difference :;Dd'j;m?na;f
[ Lag ta prnter Alarmn delay [] D e, E
Pratection Scale as Connect to
| 3
7. Click OK to save and exit.

Task 6: Enable User
Administration

configuration is started.

Now we must make sure that all these settings take effect, and we do this by
telling the system to activate the User Administration program when the
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Step Action

1. Open the System Configuration module and go to the Access Control tab.
2. At the top, clear the check box called Disable access control.
3. Put a check mark in Allow permanent user login and Save latest user logged in.
4. Go to the Supervise & Language tab and select the check box called Show active user in
title bar.
5. Go to the Startup tab and under the Startup group select the radio button called Manual.
6. Close the module and click Yes to the Save possible changes dialog box.

Task 7: Test with

User Now we want to test the results of our work with setting up User Administration.

Administration

enabled

Step Action

1. Click the IGSS Starter and the starter bar comes up and the Temporary Login dialog box
appears.

2 First try to log in by using Pat as user. What happens?

3. Now try to log in by using Jim as user. What happens? Click on the Supervise button.

4. Go File » Logout and then File = Login and key in Jim again as user (and password).

What happens?

5. Go to the Refuse disposal diagram and try to control the pump p3, START or STOP. What
happens? Who has the right to control the pump?

6. Go to the Dairy diagram and right click the object q3 and select HA (High Alarm). Try to
change the HA limit to 85. What happens?

7. Log on as Pat and notice which diagram you're taken to. Go to the Dairy diagram and if
there's an alarm on g3, try to acknowledge it. What happens?

YOU HAVE SUCCESSFULLY COMPLETED THE EXERCISE
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